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Return-To-Factory Warranty
Psion Teklogix warrants a return-to-factory warranty for a period of one year.
In some regions, the warranty exceeds this period. Please contact your local
Psion Teklogix office for details. For a list of offices, see “Worldwide
Offices” on page 50. The warranty on Psion Teklogix manufactured equip-
ment does not extend to any product that has been tampered with, altered, or
repaired by any person other than an employee of an authorized Psion Tek-
logix service organization. See Psion Teklogix terms and conditions of sale
for full details.

Service
When requesting service, please provide information concerning the nature
of the failure and the manner in which the equipment was used when the fail-
ure occurred. Type, model, and serial number should also be provided.
Before returning any products to Psion Teklogix, please call the Customer
Services Group for a Return Authorization number. 

Support Services
Psion Teklogix provides a complete range of product support services to its
customers. For detailed information, please refer to “Support Services And
Worldwide Offices” on page 49. 

Disclaimer
Every effort has been made to make this material complete, accurate, and up-
to-date. Psion Teklogix Inc. reserves the right to make changes without notice
and shall not be responsible for any damages, including but not limited to
consequential damages, caused by reliance on the material presented, includ-
ing but not limited to typographical errors.
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Approvals And Safety Summary
CE Declaration Of Conformity

Product: netpad 1000 Series with Serial Docking Station

Application of Council Directives: EMC Directive: 89/336/EEC
Low Voltage Directive: 73/23/EEC

Conformity Declared to Standards: EN 55022: 1998; Class B;
EN 55024: 1998;

EN 61000-4-2; ±4kV CD; ±8kV AD
EN 61000-4-3; 3V/m, 80-1000 MHz, 900 MHz
EN 61000-4-4; ±1kV Power lines
EN 61000-4-5; ±2kV Common; 

±1kV Differential mode
EN 61000-4-6; 3VRMS, 150 kHz-80 MHz
EN 61000-4-11; AC Mains Ports

EN 61000-3-2; EN 61000-3-3
EN 60950: 1992 + A1 + A2 + A3 + A4 + A11

Manufacturer: PSION TEKLOGIX INC.
2100 Meadowvale Blvd.
Mississauga, Ontario; Canada L5N 7J9

Year of Manufacture: 2002

Manufacturer’s Address in the 
European Community: PSION TEKLOGIX S.A.

La Duranne; 135 Rue Rene Descartes
BP 421000
13591 Aix-En-Provence
Cedex 3; France

Type of Equipment: Information Technology Equipment
Equipment Class: Commercial and Light Industrial

Manufacturer: Psion Teklogix Inc. Ontario

Legal Representative in Europe: Psion Teklogix S.A. France
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CE Declaration Of Conformity
Product: netpad 3000 Series with Serial Docking Station

Application of Council Directives: EMC Directive: 89/336/EEC
Low Voltage Directive: 73/23/EEC

Conformity Declared to Standards: EN 55022: 1998; Class B;
EN 55024: 1998;

EN 61000-4-2; ±4kV CD; ±8kV AD
EN 61000-4-3; 3V/m, 80-1000 MHz, 900 MHz
EN 61000-4-4; ±1kV Power lines
EN 61000-4-5; ±2kV Common; 

±1kV Differential mode
EN 61000-4-6; 3VRMS, 150 kHz-80 MHz
EN 61000-4-11; AC Mains Ports

EN 61000-3-2; EN 61000-3-3
EN 60950: 1992 + A1 + A2 + A3 + A4 + A11
EN 60825-1, AM.2: 2001; Laser Safety

Manufacturer: PSION TEKLOGIX INC.
2100 Meadowvale Blvd.
Mississauga, Ontario; Canada L5N 7J9

Year of Manufacture: 2002

Manufacturer’s Address in the 
European Community: PSION TEKLOGIX S.A.

La Duranne; 135 Rue Rene Descartes
BP 421000
13591 Aix-En-Provence
Cedex 3; France

Type of Equipment: Information Technology Equipment
Equipment Class: Commercial and Light Industrial

Manufacturer: Psion Teklogix Inc. Ontario

Legal Representative in Europe: Psion Teklogix S.A. France
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FCC Information For The USA

FCC Declaration Of Conformity (DoC)

Applicant’s Name & Address: PSION TEKLOGIX INC.
2100 Meadowvale Blvd.
Mississauga, Ontario, Canada L5N 7J9
Tel.: (905) 813-9900

US Representative’s 
Name & Address: Psion Teklogix Corp.

1810 Airport Exchange Blvd., Suite 500
Erlanger, Kentucky, 41018, USA
Tel.: (859) 371-6006

Equipment Type / Environment: Computing Devices for Home and Office Use

Trade Name / Model No.: netpad

Year of Manufacture: 2002

Standard(s) to which Conformity is Declared:

The netpad and Serial Docking Station, supplied by Psion Teklogix, has been tested 
and found to comply with FCC PART 15, SUBPART B - UNINTENTIONAL RADI-
ATORS, CLASS B COMPUTING DEVICES FOR HOME & OFFICE USE.

Applicant: Psion Teklogix Inc.
Mississauga, Ontario, Canada

Legal Representative in US: Psion Teklogix Corp.
Erlanger, Kentucky, USA
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CE Marking
When used in a residential, commercial or light industrial environ-
ment the product and its approved UK and European peripherals 
fulfill all requirements for CE marking.

R&TTE Directive 1999/5/EC
This equipment complies with the essential requirements of EU Direc-
tive 1999/5/EC (Declaration available: www.psionteklogix.com).

Cet équipement est conforme aux principales caractéristiques défin-
ies dans la Directive européenne RTTE 1999/5/CE. (Déclaration 
disponible sur le site: www.psionteklogix.com).

Die Geräte erfüllen die grundlegenden Anforderungen der RTTE-
Richtlinie (1999/5/EG). (Den Wortlaut der Richtlinie finden Sie 
unter: www.psionteklogix.com).

Questa apparecchiatura è conforme ai requisiti essenziali della Diret-
tiva Europea R&TTE 1999/5/CE. (Dichiarazione disponibile sul 
sito: www.psionteklogix.com).

Este equipo cumple los requisitos principales de la Directiva 
1995/5/CE de la UE, “Equipos de Terminales de Radio y Telecomu-
nicaciones”. (Declaración disponible en: www.psionteklogix.com).

Este equipamento cumpre os requisitos essenciais da Directiva 
1999/5/CE do Parlamento Europeu e do Conselho (Directiva RTT). 
(Declaração disponível no endereço: www.psionteklogix.com).

Ο εξοπλισµός αυτός πληροί τις βασικές απαιτήσεις της κοινοτικής 
οδηγίας EU R&TTE 1999/5/EΚ. (Η δήλωση συµµόρφωσης 
διατίθεται στη διεύθυνση: www.psionteklogix.com)
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Deze apparatuur voldoet aan de noodzakelijke vereisten van EU-
richtlijn betreffende radioapparatuur en telecommunicatie-eindappa-
ratuur 199/5/EG. (verklaring beschikbaar: www.psionteklogix.com).

Dette udstyr opfylder de Væsentlige krav i EU's direktiv 1999/5/EC 
om Radio- og teleterminaludstyr. (Erklæring findes på: 
www.psionteklogix.com).

Dette utstyret er i overensstemmelse med hovedkravene i R&TTE-
direktivet (1999/5/EC) fra EU. (Erklæring finnes på: 
www.psionteklogix.com).

Utrustningen uppfyller kraven för EU-direktivet 1999/5/EC om 
ansluten teleutrustning och ömsesidigt erkännande av utrustningens 
överensstämmelse (R&TTE). (Förklaringen finns att läsa på: 
www.psionteklogix.com).

Tämä laite vastaa EU:n radio- ja telepäätelaitedirektiivin 
(EU R&TTE Directive 1999/5/EC) vaatimuksia. (Julkilausuma 
nähtävillä osoitteessa: www.psionteklogix.com).

Use of the 802.11 netpad in France:
Owing to French Government restrictions, the French 802.11 
netpad is limited to indoor use. They may be used outdoors, on 
private property, only with prior authorization from the French 
Ministry of Defense.
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FCC Information To The User

Radio And Television Interference
This equipment radiates radio frequency energy and if not used 
properly—that is, in strict accordance with the instructions in this 
manual—may cause interference to radio communications and tele-
vision reception. It has been tested and found to comply with the 
limits for a Class B digital device pursuant to part 15 of the FCC 
Rules. Operation is subject to the following two conditions:

1. This device may not cause harmful interference, and 
2. This device must accept any interference received, includ-

ing interference that may cause undesired operation.
These limits are designed to provide reasonable protection against 
harmful interference in a residential installation. However, there is 
no guarantee that interference will not occur in a particular installa-
tion. If this equipment does cause harmful interference to radio
or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation distance between the equipment and 

the receiver.
• If you are using the equipment with a mains adaptor, plug it 

into an outlet which is on a different circuit from that to 
which the receiver is connected.

• Consult an experienced radio/TV technician for help.
For customers in the USA, the following booklet prepared by the 
Federal Communications Commission may be of help: “How to 
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Identify and Resolve Radio-TV Interference Problems”. This 
booklet is available from the US Government Printing Office, 
Washington, DC 20402 - Stock No 004-000-00345-4.

Radio Frequency Emissions
Do not use in aircraft or hospitals. Some equipment in hospitals and 
aircraft are not shielded from radio frequency energy. Do not use the 
netpad onboard aircraft, or in hospitals, without first obtaining per-
mission.

Do not use near pacemakers. The product may affect the operation 
of some medically implanted devices such as pacemakers, causing 
them to malfunction. Avoid placing your product next to such 
devices. Keep a minimum distance of 15 cm between the device and 
the product to reduce the risk of interference. If you have any reason 
to suspect that interference is taking place, turn off the netpad and 
contact your cardiologist for assistance.

Note: In August 1996 the Federal Communications Commission 
(FCC) of the US adopted an updated safety standard for 
human exposure to radio frequency energy emitted by FCC 
regulated transmitters. The design of this product complies 
with the FCC guidelines and those standards.

To maintain compliance with the FCC RF exposure guide-
lines, if you wear the netpad on your body, use the supplied 
or approved carrying case, holster, or other body-worn 
accessory (see page 22 for details). If you do not use a body-
worn accessory, ensure the antenna is at least 1.5 cm from 
your body when transmitting. Use of non-approved accesso-
ries may violate FCC RF exposure guidelines.
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Important Safety Instructions
This equipment was tested for FCC compliance under conditions 
that included the use of shielded cables and connectors between it 
and the peripherals. It is important that you use shielded cable and 
connectors to reduce the possibility of causing radio and television 
interference. Shielded cables, suitable for the netpad, can be 
obtained from an authorised Psion Teklogix dealer.

If the user modifies the equipment or its peripherals in any way, and 
these modifications are not approved by Psion Teklogix, the FCC 
may withdraw the user’s right to operate the equipment.

Emissions Information For Canada
This Class B digital apparatus meets all requirements of the Cana-
dian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences 
du Règlement sur le matériel brouilleur du Canada.

Infrared Device Safety

Class 1 LED Product
This product includes an Infrared device for transmitting and receiv-
ing files from devices supporting the IrDA format. Although this 
invisible beam is not considered harmful, and complies with 
EN60825-1 (IEC825-1), we recommend the following precautions 
when the Infrared device is transmitting:

• Do not stare into the Infrared beam.
• Do not view directly with optical instruments.

No parts in the device may be serviced by the user.
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Integrated Scanner Safety
For your own safety, it is critical that you comply with the warnings 
described in “The Scanner” on page 34.

Battery Safety Precautions

CAUTION!
Danger of explosion if a netpad battery is incorrectly handled, 
charged, disposed of or replaced. Replace only with the same or 
equivalent type recommended by the manufacturer. Dispose of used 
batteries according to the instructions described in “Lithium-Ion 
Battery Safety Precautions”, below. Carefully review all battery 
safety issues listed in that section.

VORSICHT!
Explosiongefahr bei unsachgemäßem Austausch der Batterie Ersatz 
nur durch denselben oder einen vom Hersteller empfohlenen gleich-
wertigen Typ. Entsorgung gebrauchter Batterien nach Angaben des 
Herstellers.

Lithium-Ion Battery Safety Precautions
Do not store batteries at temperatures in excess of +60°C; the optimum 
storage temperature for maximum battery life is +10°C to +35°C.

Important: It is critical that this safety information be reviewed 
and that all warnings be strictly followed.
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BATTERIES ARE CONSIDERED HAZARDOUS WASTE. Used 
batteries must be disposed of in accordance with the manufacturer’s 
instructions, taken to an appropriate local battery recycling facility, 
or returned to one of the following Psion Teklogix offices for proper 
disposal. 
Teklogix Inc. Teklogix Corp. Teklogix S.A.
2100 Meadowvale Blvd. 1810 Airport Exchange Blvd. Parc Club Du Golf-Bat 1.
Mississauga, Ontario Suite 500 13856 Aix-En-Provence
Canada Erlanger, Kentucky Cedex 3
L5N 7J9 USA 41018 France

Warning: TO PREVENT the battery from leaking acid, generat-
ing heat or exploding, adhere to the precautions listed 
below.

• Use only with the authorized Psion Teklogix power 
adaptor.

• Do not dispose of in fire.
• Do not incinerate or subject battery cells to tempera-

tures in excess of 100°C (212°F). Such treatment 
can vaporize the liquid electrolyte causing cell 
rupture. Incineration may result in harmful emis-
sions or explosion.

• Do not charge, use or store batteries below -30º C 
(-22° F). Batteries must be handled in accordance 
with all applicable state and federal laws and 
regulations.

• The battery incorporates built-in safety devices. To 
ensure their proper function, do not disassemble or 
alter any parts of the battery.
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• Do not short-circuit the battery by directly connect-
ing any of the exposed terminals with metal objects 
such as wire. Do not transport or store the battery 
together with metal objects such as necklaces, hair 
pins, etc.

• Do not use or leave the battery near a heat source 
such as a fire or heater.

• Do not immerse the battery in water.
• When charging, use the battery charger specifically 

designed for the battery.
• Do not crush, puncture, open, dismantle, or other-

wise mechanically interfere with batteries.
• Do not directly solder the battery.
• Do not connect the battery to an electrical outlet, 

vehicle cigarette lighter, etc.
• Do not put battery into a microwave oven or pressu-

rized container.
• Do not use the battery in combination with primary 

batteries (such as dry-cell batteries) or batteries of 
different capacities or brands.

• Immediately remove the battery from the device or 
battery charger and stop use if the battery gives off an 
odour, generates heat, becomes discoloured or 
deformed, or in any way appears abnormal during use.

• Do not continue charging the battery if it does not 
recharge within the specified charge time.

• The battery may burst or ignite if the battery leaks. 
Always ensure that it is away from any exposed 
flames.
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• If a battery should leak, do not allow the contents to 
come into contact with your skin or your eyes. If it 
does, wash immediately with plenty of cold water 
and seek medical advice.

• Do not store the battery in extremely high tempera-
tures (e.g., a vehicle, strong direct sunlight, etc.). 
This may cause the battery to overheat or ignite, and 
it may also reduce the performance and service life 
of the battery.

• Do not use in areas where static electricity is greater 
than what the manufacturer guarantees.

• Keep batteries out of reach of children.
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1.  Introduction
This guide provides information on the operation and features of the 
Psion Teklogix netpad. For additional information, refer to the 
netpad EPOC User Manual, the online help, the documentation sup-
plied with the application you are using, and PsiWin online help, 
available on your PC when PsiWin is installed.

1.1  Applications Installed On The netpad
The netpad is capable of running a wide variety of applications but 
the ones available on your particular netpad depend on the purpose 
for which the netpad is provided. A number of standard applications 
exist and custom programs can be installed easily.

The following standard programs are available:

• Word, a word processor for writing letters and other docu-
ments.

• Sheet, for spreadsheets, tables, and graphs.
• Contacts, an address book.
• Agenda, a diary program for appointments and lists of things 

to do.
• Email, for sending and receiving e-mail, SMS and fax mes-

sages.
• Opera, for browsing the World Wide Web.
• Calc, a calculator with general and scientific features.
• Jotter, a notebook for jotting down ideas quickly.
• Time, for alarms and a world map with international times 

and dialling codes.
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• Data, a customizable database program.
• Sketch, for drawing pictures.
• Record, for recording and editing voice memos and sounds.
• Program, the editor in which you can create programs using 

the built-in programming language.
• Spell, for checking spelling, thesaurus, solving anagrams and

crossword clues.
• Comms, for terminal emulation and file transfer.

1.2  Caring For The netpad
Screen
When used with the approved stylus, the netpad screen is very resist-
ant to wear and impact and should last for a considerable time. Use 
of any object, other than the approved stylus, may result in damage 
to the netpad screen. 

To maintain the life of the netpad screen, keep the screen clean. To 
clean the screen: switch off the netpad and use a soft, clean, dry cloth 
to gently wipe the screen. (If the netpad is set to turn on automati-
cally when the screen is tapped, you should turn this preference off 
before cleaning the screen.)

Warning: Under no circumstances use chemical solvents to clean 
the screen.

Charging
To avoid damage to the netpad or the netpad battery packs, use only 
Psion Teklogix approved chargers and docking stations.
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Backup Battery
The netpad has a rechargeable backup battery designed to retain data 
while the main battery pack is charging or changed over.

The backup battery is trickle charged from the main battery pack and 
has a limited lifespan. To maximize the life of the backup battery, 
avoid excessive discharging and recharging of the backup battery by 
keeping the netpad battery pack fully charged.

Important: If both the main battery pack and the backup battery 
are allowed to fully discharge, all user data held in 
RAM will be lost.

The backup battery is not user replaceable. If the backup battery 
requires replacement the netpad must be returned to a Psion Tek-
logix approved service centre.

Drop Rating
The netpad is designed to survive being dropped on any face, onto 
concrete, from a height of 1.5 m (5 ft.).

Dropping the netpad from greater heights or onto harder surfaces 
may result in damage to the netpad.

IP Rating
The netpad is rated to IP67 and can survive submersion in water to a 
depth of 1 m (3.3 ft.) for up to 30 minutes. Submersion below this 
depth or for longer periods may result in damage to the netpad. 

Operating Temperature
The netpad is designed to operate within the temperature limits of 
-20°C to +60°C (-4°F to 140°F); and -20°C to +55°C (-4°F to 131°F) 
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for scanner variants. Use of the netpad outside of these temperature 
limits may reduce its life. 

Avoid exposing the netpad to sudden changes in temperature, since 
such exposure may result in damage.

Important: As a safety precaution, charging the netpad battery 
should be limited to the temperature range: -20°C to 
+60°C (-4°F to 140°F); and -20°C to +55°C (-4°F to 
131°F) for scanner variants. Outside of these limits, 
the safety circuits of the netpad battery pack will not 
allow the battery to charge.

Storage Temperature
The netpad is designed to be stored within the temperature ranges of 
-25°C to +70°C (-13°F to 158°F); and -25°C to +60°C (-13°F to 
140°F) for scanner variants. Storage of the netpad outside of these 
temperature limits may reduce its life. 

To prolong the life of the netpad battery packs during normal stor-
age, store the netpad (and the battery pack) between +10°C and 
+35°C (+50°F and +95°F).

When storing the netpad for a long period of time, the main battery 
should be removed and stored fully discharged.

Humidity
The netpad is designed to operate in humidity ranging from 0 to 
95%. Use of the netpad in environments with condensing humidity 
or humidity outside these limits may result in damage to the netpad.
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Magnetic Fields And Static Electricity
The magnet of the netpad speaker may corrupt data stored on mag-
netic media. Do not keep the netpad next to credit cards or other 
magnetic media. 

Avoid exposing the netpad to strong magnetic fields or static elec-
tricity. Such exposure may cause loss of data or result in damage to 
the netpad.

Service
Do not attempt to dismantle the netpad. 

There are no user-serviceable parts inside, and any attempt to dis-
mantle the netpad will invalidate the warranty.

1.3  Additional Programs And Third Party Applications
Psion Teklogix has partnered with a number of companies to provide 
a suite of connectivity and database tools for the netpad. Details are 
available on the Psion Teklogix Partner Program web site at: 
http://partners.psionteklogix.com/partners/.

                                                                                                                                                                   

2.  Getting Started

2.1  Features Of The netpad
The EPOC netpad is a 32-bit mobile tablet computer with a 1/2 
VGA touch-sensitive screen. netpad is lightweight, shock and water-
resistant, and designed for use in a wide range of business areas 
including field service, field sales, transport, health care, hospitality, 
manufacturing and insurance. It is available in variants with internal 
GSM/GPRS, 802.11b radios and scanners.
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Figure 2.1 netpad Front 

Figure 2.2 Back Of netpad
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2.2  Preparing The netpad For Use

2.2.1 Fitting The Antenna
Before using netpad units fitted with either the GPRS or 802.11 
radio, the antenna must be installed. The antenna should be installed 
as shown in Figure 2.3 below. To install the antenna turn it counter 
clockwise; to remove the antenna turn it clockwise.

Figure 2.3 Antenna Insertion And Removal
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2.2.2 Use Of The Soft Belt Holster

Figure 2.4 Insertion Of netpad In Holster

Important: The netpad and holster have been tested to ensure 
compliance with the latest FCC RF exposure guide-
lines. For continued compliance when using the 
netpad and holster combination, the face shown 
should be fitted against the body! The user must not 
modify the holster in any way.

Figure 2.5 Holster Position On Body
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2.2.3 Power Management
The netpad is powered by a Lithium Ion rechargeable battery pack, 
which under optimal operating conditions will provide power for a full 
shift. The netpad will warn you when the main battery charge is low.

Note: How long your batteries last will depend upon how you use 
your netpad. The netpad will use considerably more battery 
power when you are recording sounds, have the brightness 
turned up, are using files stored on a multimedia card, or are 
using Infrared.

You can take steps to help prolong your battery’s life:

• Turn the screen brightness down.
• Set automatic switch-off in the Power control panel.
• Use files on the internal disk instead of an MMC, as the 

netpad requires more power to write to the multimedia 
card.

The netpad can be powered from AC when used in the docking sta-
tion (see page 47). When the netpad is powered from the docking 
station, it will also charge the battery pack.

Fitting The Battery
Before you can use the netpad you must fit the battery—slide it into 
place until it clicks, as shown in Figure 2.6 on page 25.

Important: Take care when replacing batteries! The netpad will 
warn you when its main battery is getting low, in 
plenty of time to change/charge it. The backup 
battery is designed to maintain the memory for 
several hours. However, prolonged reliance on the 
backup battery does reduce its life. 
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Charging The netpad Battery Pack
To charge the battery, attach the battery pack to the netpad and place 
the complete netpad in a netpad docking station (for instructions, 
please refer to page 47), or place the battery in one of the optional 
battery chargers. The standard (850 mAH) netpad battery will nor-
mally be fully charged within 2 to 2.5 hours (3 hours for a 1400 
mAH battery pack).

How Do I Check The Battery Power?
To check the battery power, tap the Menu icon to the right of the 
screen (see “The Screen, Command Icons, And Toolbar” on page 
32), and select the Information menu, then Battery. The Summary 
panel gives a brief description of the state of the main battery and the 
backup battery as well as a percentage of charge remaining.

Changing Battery Packs
If you are using your netpad away from the charger and a spare bat-
tery pack is available, you can change batteries when the battery 
warning is displayed. To do this:

1. Switch the netpad off.
2. Press on the battery pack latch to remove it (see Figure 2.6 

on page 25).
3. Push in the replacement battery pack.
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Figure 2.6 Battery Insertion

Important: Always switch off the netpad before removing the 
main battery. 

Never remove the battery from the netpad while it is 
in the docking station. 

Never use a netpad without a battery in the docking 
station.

Prolonging Battery Life
When your netpad is switched off, it is on “standby” and will con-
tinue to use a small amount of battery power. If you are going to 
leave your netpad switched off for a long period of time, you are 
advised to back up your data beforehand because the batteries will 
eventually run out.

Note: To check the battery power, open the Power icon from the 
Control Panel.

Battery Pack
Direction of
Insertion

Battery
Latch

Battery Contact Pins
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Internal Backup Battery
The netpad has a rechargeable backup battery designed to retain data 
while the main battery pack is charging or changed over. The backup 
battery is trickle charged from the main battery pack and has a lim-
ited lifespan. To maximize the life of the backup battery, avoid 
excessive discharging and recharging of the backup battery by keep-
ing the netpad battery pack fully charged. 

Important: If both the main battery pack and the backup battery 
are allowed to fully discharge, all user data held in 
RAM will be lost.

The backup battery is not user replaceable. If the backup battery 
requires replacement, the netpad must be returned to a Psion Tek-
logix approved service centre.

Important: If both the batteries run out of power you will lose all 
your information on the internal disk.

2.2.4 Multimedia Cards
Multimedia cards (MMCs) are non-volatile memory cards, which fit 
into a dedicated slot in the netpad and can be used to store applica-
tion software and/or data. 

The MMC slot is located on the right hand side of the netpad. 

Inserting And Removing An MMC
• Open the card slot door located on the side of the unit by slid-

ing the retaining latch. Push the MMC into place until it 
clicks. Close the door.
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• To remove an MMC, open the door and push the card. Store 
your MMC safely, particularly if it contains valuable data.

Figure 2.7 MMC Slot Location

2.2.5 Installing And Removing The SIM Card

A netpad fitted with a GSM/GPRS radio requires a Subscriber Iden-
tity Module (SIM) card installed in order for the netpad to access the 
GSM network. The SIM card fits into a dedicated slot in the netpad. 

The SIM card slot is located behind the Card Slot door on the right-
hand side of the netpad; and is located below the Multimedia card 
(MMC) slot (see Figure 2.8 on page 28).

Card Slot Door Latch

MMC Card

Reset
Button
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Figure 2.8 Location Of SIM Card And MMC

Important: The MMC slot and SIM card slot are located very close 
together. When inserting or removing the SIM card be 
careful not to drop the SIM card into the MMC slot.

Inserting The SIM Card

Warning: To prevent damage to the SIM card, ensure that the 
netpad is switched off and the battery removed before 
inserting the SIM card.

• Remove the battery pack from the netpad.
• Open the card slot door located on the side of the unit by slid-

ing the retaining latch. 
• Push the SIM card into place until it is fully inserted. Note 

the orientation of the card, shown in Figure 2.9 on page 29, 
with the notch of the card on the left, trailing side. Close 
the door.

SIM Card

MMC

Card Slot Door

(screen side up)
Orientation of netpad
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Figure 2.9 Insertion Of SIM Card

Important: Ensure that the SIM card is inserted in the correct 
orientation as shown. Once inserted, the SIM card 
can only be removed using a pair of tweezers or long-
nosed pliers. If the SIM card is inserted incorrectly, 
the unit will not connect to the GSM network. 

If the SIM card is inserted incorrectly, it must be 
removed by following the instructions on page 30: 
“Removing The SIM Card”.

Removing The SIM Card

Warning: To prevent damage to the SIM card, ensure that the 
netpad is switched off and the battery removed before 
removing the SIM card.

• Open the card slot door and grasp the card on the cross-hatch 
area (see Figure 2.10 on page 30), using the special removal 
tool supplied, a pair of tweezers, or long-nosed pliers. Pull the 
card out carefully.

MMC

SIM Card

SIM Card SlotOrientation of Card
(notched corner)
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Figure 2.10 Removal Of SIM Card

2.3  Turning On And Off
To switch on: 

press the On/Off button on the top. When you first do this, 
you’ll see the System screen.

Note: The ability to turn on the unit by tapping the screen is config-
ured and controlled by a setting under the Power Icon on the 
Control Panel. The netpad can also be switched on under 
program control, such as when an alarm rings.

To switch off: 
press the On/Off button on the top. You can switch off at any 
time. You do not have to save your information first, as it is 
automatically saved for you. However, if you are working with 
a file on the MMC, save the file before switching off the netpad 
and removing the card.

MMC

Orientation of netpad

Cross-hatched Area of SIM Card

(screen side down)

(grip here with pliers)
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Note: If you do not use the netpad, it will automatically switch off 
after 5 minutes to save battery power. Switch it on again, and 
you can continue from where you left off. (The time for auto-
matic switch off can be modified via the Control Panel.) The 
netpad also has other features for minimizing its power con-
sumption and maximizing battery life. These features can be 
accessed via the Control Panel.

2.4  Finding And Using The Stylus
The stylus is located in a holder at the right. To remove it, slide the 
stylus out of the top of the netpad. To replace it, push it back in.

Tap lightly on the screen using the stylus. You can use your fingers 
to tap on the screen, though it is best to use the stylus to avoid finger-
prints or smudges on the screen. Do not tap the screen with any 
object that has a sharp tip or you may damage the screen. Don’t use 
any type of ink pen, as the ink may be impossible to remove. See 
“Caring For The netpad” on page 16 for instructions on how to clean 
the screen.

You can usually tap on an item with the stylus to select or change it. 
For example, you can tap on:

• the program icons, to open a program.
• the command icons, for “shortcuts” to System functions, 

e.g. the menu bar, cutting and pasting, Infrared, zooming in 
and out.

Note: If the screen doesn’t respond to your taps, you may need to 
re-calibrate it. You can do this by opening the Screen icon 
from the Control Panel
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2.5  The Screen, Command Icons, And Toolbar
The netpad screen has a column of permanent “command icons” on 
the right-hand side. From top to bottom, these are:

Menu: 
Displays the menus for the current program. Menus 
are displayed along the top of the screen.

Contrast and brightness control: 
Tap the icon repeatedly to cycle through the default 
brightness levels.

Important: Battery life is considerably reduced when 
the brightness is increased.

Zoom control: 
Tap the icon repeatedly to cycle through the zoom set-
tings. The settings depend on the application you are 
in, and are stored independently for each application.

Keyboard: 
Displays the Psiboard, the on-screen keyboard.

System command icon: 
When you are in a program, the System command icon displays 
the System screen. From the System screen, tapping the icon 
displays the Program bar containing the icons for the programs 
installed on your netpad.

When you are in a program, the program’s Toolbar is usually dis-
played to the left of the command icons. This Toolbar contains four 
icons with the name of the program above them. Tapping on the 
name displays the list of open files and folders. Below the name are 
four icons that vary from program to program and are the most com-
monly used functions for each program.
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2.6  How To Reset The netpad
If you find that you cannot exit a program normally, move to the 
System screen and select the List open files command from the File 
menu. Select the program from the list and press the Close file but-
ton. If this does not work, or if your netpad appears to have “locked 
up”, you can always perform a “soft reset”. This should restart your 
netpad while preserving most of your information. 

It is worth trying a soft reset if the keys on the netpad do not appear 
to respond, or if the netpad appears to switch on and you are sure that 
the batteries are good (especially if the contrast adjustment still 
appears to work), but the screen is otherwise blank.

To perform a soft reset: 
gently press the stylus onto the reset button. This is located 
inside the card slot door cover to the side of the MMC slot.

Figure 2.11 Reset Button Location

Press the On/Off button to restart the netpad—you will hear two 
beeps during boot-up to indicate the reset. After a soft reset, any 
changes to open files will be lost. Your other files on the internal disk 

MMC

SIM Card

Reset Button
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will almost always be safe.

It is possible (although unlikely) that performing a soft reset after a 
program failure may cause the netpad to lose the information on the 
internal disk; it could even prevent the reset from working at all. If 
this happens, you will have to perform a “hard reset”.

Important: A hard reset resets the netpad completely, and all 
information on the Internal disk will be lost.

To perform a hard reset: 
1. Remove the netpad from the docking station (if applicable).
2. Remove the main battery.
3. Press and hold down the On/Off button (on the top of 

the unit).
4. While continuing to hold down the On/Off button, press and

release the Reset button. 
5. Release the On/Off button.
6. Refit the battery into the netpad—the unit will power up 

and you will hear one beep during boot-up.

2.7  The Scanner
Where fitted with a bar code scanner, the netpad may be used to read 
industry standard bar codes. 

To scan a bar code, point the scanner window at the bar code, ensur-
ing that the scanner window is not obstructed and that you are 
between 5 cm (2 in) and 60 cm (24 in) from the bar code. Activate 
the scanner as instructed in the software application’s operating 
instructions. The scanning beam should be energized until a success-
ful decode is achieved or three seconds have elapsed.
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Figure 2.12 Scanner Location

Warning: For your own safety, it is critical that you comply with 
the following warnings:

1. Do not look into the scanner window.
2. This product contains a laser scanner that emits 

less than 1.2 mW average radiant power at a wave-
length of 650 nm. This product complies with 21 
CFR 1040.10, 1040.11 and DIN EN 60825-1: 
January 2001, and is classified as a Class 2 laser 
product.

3. CAUTION – Using controls or adjustments, or per-
forming procedures other than those specified 
herein may result in hazardous radiation exposure.

4. CAUTION – The use of optical instruments with 
this product will increase eye hazard.

Scanner Window
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2.8  First Steps
When you first switch on the netpad, you will see the System screen. 
This is the “desktop” where you can view your files and folders, and 
change settings that control how the netpad works.

• All the information you enter into the netpad is contained in 
files; their names are displayed in the System screen, beside 
icons that represent the programs that created them.

• All your files are stored in folders. When you start using the 
netpad, the contents of the Documents folder is displayed.

• The System screen’s Title bar shows you which folder is cur-
rently displayed on the screen. When you start, you are in the 
Documents folder on the C (Internal) drive.

You can have as many folders as you wish, and create folders within 
other folders. Folders can contain files created in a variety of pro-
grams; they are not restricted to files from a single program.

2.8.1 Aligning The Touch Screen
You can ensure that the touch screen is properly calibrated using the 
Screen menu.

1. In the System screen, tap on Control Panel on the Toolbar, 
or select the command from the Tools menu.

2. Tap the Screen icon.
3. The Screen settings dialogue comes up. Tap the Cali-

brate button at the side of the page, then follow the 
instructions on the screen. You will be asked to tap the 
centre of each point indicated on the screen. At the conclu-
sion of the test, the calibration will be completed when you 
accept the new settings by tapping on the Yes button.
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2.8.2 Navigating Between Files And Folders
• Tap on a folder icon to move to that folder, tap on the Close 

folder icon to close it and move back up a level.
• Tap on a file to select it, tap again to open it. If the file name 

is displayed in bold, the file is open, and tapping it will move 
straight to the file.

2.8.3 Starting Programs
When you open or move to a file, the correct program for this file is 
started automatically. You can also start programs by tapping on the 
appropriate program icon.

• If necessary, tap the System icon  at any time to move to 
the System screen.

• Tap on it again to display the Program icon bar, which con-
tains more program icons.

You don’t have to close one program before opening another, just tap 
on another program icon, and that program will open too.

 

Title Bar

Folder

Command

Toolbar

Current Folder
Icon Bar



38 Psion Teklogix netpad EPOC Quick Start Guide

You can see what files and programs are open from the System 
screen by using the List open files command from the File menu, or 
by tapping on the name in the top right corner of the screen.

2.8.4 Programs And Files
When you run a program, it will usually display the currently open 
file, or the file that you last looked at. If you want to write a new let-
ter, draw a new picture, create a new database and so on, you’ll need 
to create a new file for the particular program involved.

To create a new file: 
select the Create new file command on the File menu and type 
in the name for the new file (see “Entering Information” on 
page 39). The file will now be created, and the current file will 
be closed and saved at the same time. You can start entering 
your information.

You can also use this command in the System screen to create a new 
file. Usually, this creates a file using the standard settings; creating a 
file from within a program creates a file that already has any settings 
or preferences you have set up in the program.

It is a good idea to keep related files together in a folder, to make the 
files easier to find later. 
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2.8.5 Entering Information
You can enter information and complete tasks using the stylus or the 
Psiboard. The Psiboard is displayed by tapping the Keyboard com-
mand icon. 

You can:

• Move the keyboard by tapping the title bar and dragging it.
• Resize the keyboard by dragging the bottom right-hand corner.
• Minimize the keyboard by tapping the underline symbol on 

the top right-hand corner of the keyboard.

• Maximize the keyboard again when you need to type some-
thing, by tapping the underline symbol.

Tap the P symbol to display and set the keyboard preferences; for 
example if you’re using a program such as Word in which you need 
to type a lot of text, you may want to set ‘Always on top’ to prevent 
the Psiboard from disappearing every time you tap on another part of 
the screen. Then, to move the Psiboard out of the way, minimize it.

Sizing Corner
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When you are in a dialogue in which you need to enter information, 
Psiboard is displayed in a different mode. When you tap twice in a 
line, the keyboard opens. As you type the text is shown. When you 
tap Done, the keyboard closes and the line of text is entered in to the 
dialogue. You can use the Next and Prev buttons to move between 
items on the dialogue.

Note: Psiboard is the netpad’s default keyboard. If you load a dif-
ferent keyboard you can use this instead. In the Control 
Panel, select the Text input icon, and select the new applica-
tion from the list.
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2.8.6 Displaying Help
Help can be displayed at any time from the standard netpad pro-
grams including the System screen. Help information is contained 
on a series of “Help cards”. Help is specific to the program that you 
are using; wherever you are, you can just type a “clue” to search for 
the information you need.

Note: The online help contains more detailed information than is 
included in this guide.

To display Help: 
Select the Help command from the Tools menu. In the System 
screen, general help on the netpad is also available.

To search for help about something: 
type your clue into the Find: box, and press Enter. If the Quick 
find button is selected from the Toolbar, the display will show a 
list of Help cards with the clue in the title or initial description. 
Alternatively, if the Find in all button is selected, the display 
will list all cards with the clue in the text. To move between 
cards, tap on the Prev or Next buttons, press Enter, or use the 
left and right arrow keys.

To look through the help text: 
drag the scroll bar on the side of the Help card, or tap the up and 
down arrow keys.

To print the current Help card: 
tap the Print button on the Toolbar or select Print from the 
File menu.

To type in another search word: press Esc, and then type in the 
word to search for as before. To use one of the last five search 
words again, tap on the button next to the Find: box, or press 
Tab and select the word you want to use.
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To return to the program you were using: 
tap the Go back button on the Toolbar, or tap the 
program’s icon.

Note: You can highlight text in a Help card using the stylus or key-
board, and copy it to use in a file of your own. Copy the text 
by selecting the Copy command from the Edit menu. Then go 
to your own file, and paste it in.

2.8.7 Using Menus
You can usually select a menu command to perform each task.

• Press the Menu key on the Psiboard or tap on the  com-
mand icon to see the available commands on the Menu bar.

• Tap on the menu names and commands, or use the arrow keys 
to move around the menus. Tap on commands marked with a 

 or press the right arrow key to see further commands.

Go Back Without

Text Found By Search Help Topics In Card Browser

Search Clue Help On Topic Card
Closing Help
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Note: You can press the short-cut key combinations shown next to 
the commands as a quick way of selecting them, e.g. Ctrl+M, 
means hold down the Ctrl key and press the M key at the 
same time.

A menu command with three dots at the end means that selecting the 
command will display a “dialogue” where you enter more informa-
tion (see Section 2.8.8).

If a menu command is grey, it means that it’s not currently available; 
e.g. you cannot Copy unless you have first selected something to copy.

2.8.8 Using Dialogues
A “dialogue” appears when you need to make selections and enter 
further information. You can move between dialogue items by tap-
ping on them, or using the up and down arrow keys. Dialogues con-
tain one or more of the following elements:

Textbox: 
where you just type in your information. When you tap in the 
textbox, Psiboard opens so you can type in.

Listbox: 
where you select from a number of options. You will see left 
and right arrows around the current selection; you can change 
the selection by tapping on the arrows, by pressing the left and 
right arrow keys, or by typing the first letter of the option you 
want. You can usually tap in the box or press the Tab key to see 
a list of the available options.

Checkbox: 
where you make a choice between selecting an option or not 
selecting it. Just tap on the checkbox, or press the left and right 
arrow keys to add or remove a checkmark.
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Radio buttons: 
where you make one choice from a number of options. Just tap 
on an option, or use the left and right navigation buttons to 
make a selection.

If a dialogue line is grey, it is currently not available, usually because 
you have to select something else first. For example, if you have not 
checked the box to set an alarm for an Agenda entry, the lines to set 
the alarm time and date are grey. Some dialogue lines only appear 
when another option has been chosen.

Some dialogues comprise a number of “pages”, each page has a 
“tab” at the top. Tap on the tab, or move the highlight to the tab 
name, to go to that page. You can also move a dialogue around the 
screen by holding the stylus on the dialogue title bar and dragging it 
across the screen.

Dialogue Page

Radio Button

Listbox
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Dialogue Buttons
Dialogues may have on-screen buttons. Tap on the button. Some but-
tons have a standard keypress equivalent:

• Usually, you can tap the OK button or press the Enter key if 
you want to save information and remove the dialogue.

• Tap the Cancel button or press the Esc key if you want to 
remove the dialogue without saving the information.

• For dialogues that ask a question, you can tap the Yes button 
or press the Y key for ‘yes’; tap the No button, press the N key, 
or press the Esc key for ‘no’.

How To Display A Calendar
In most dialogues in which you can type a date, move to the date line 
then tap again or press Tab to display a calendar.

Today’s date is circled, and the date currently displayed in the dia-
logue is highlighted. To select another date, move to the date you 
want and press Enter. Use the buttons on the top line, or further 
presses of the Tab key, to display a three month or twelve month cal-
endar. Use the “dog ears” to move between the pages of the calendar.

You can also display a calendar from the Agenda program. See the 
Agenda document for more details.

2.8.9 Copying Information Between Programs
You can insert information created in one program into a different 
program. This is known as “inserting” an “object”.

For example, you may want to add a picture to a letter you are writ-
ing. To do this, write the letter as normal, for example using the 
Word program. Then, while in Word, tap the Insert sketch button on 
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the Toolbar or select the command from the Insert menu. This will 
start the Sketch program (if it is installed), where you can create the 
picture. Close Sketch when you have finished and the picture will be 
inserted into your letter.

Sometimes the object you insert can be displayed as an icon, for 
example, if you insert a large amount of Word text into an Agenda 
entry. (Agenda is netpad’s standard calendar program.) Alterna-
tively, you may prefer to see the actual information added, e.g. a map 
to view in the Word file.

For example, you may wish to:

• insert tables of figures and graphs from a spreadsheet such as 
Sheet into a Word file. You can add labels and titles to the 
graph in Sheet before inserting it in the Word file.

• keep a map of how to find a restaurant as a sketch, perhaps 
attached to an Agenda entry for the day that you’re going 
there.

• create a Sketch file of your signature, and insert the signature 
when you write letters in the Word processor.

• keep handwritten notes and ideas in Sketch. You can then 
insert them into the Jotter notepad program or a Word file if 
necessary.
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3.  The netpad Docking Station
This section describes the netpad docking station. The docking 
station is used as a convenient “drop-in” holder for the netpad, 
supplying power and communications through the docking station 
connector.

3.1  Using The Docking Station

Figure 3.1 Docking Station Features

To insert the netpad into the docking station, align the two devices, 
and press down on the netpad until the connection is made. To eject, 
press down on the release button at the top of the docking station. 
The netpad will be pushed up and out of the docking station.

netpad Connectors Communication Ports

Power Jack

IR Ports
Release Button

Yellow LED indicates 
communications

Red LED indicates charging/
Green LED indicates charged

Red LED indicates power
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While the netpad is in the docking station, the communications port 
on the netpad can still be used. The docking station communications 
port is available for convenience.

You can rotate the orientation of the docking station on its stand. 
Hold the top of the docking station in one hand and the bottom in the 
other. Lift the top part to release it and rotate through 90°. When you 
let go of the top part, it will click into place.

3.2  Communications Settings
When performing PC communications, it is necessary to define the 
communication settings.

In the Link to desktop dialogue (from the Tools menu in System 
screen), the Link options are: Off, Cable, or Infrared. 

• Cable specifies using the RS232 communications port on the 
left-hand side of the machine. 

• Docker specifies using the RS232 communications port on 
the right-hand side of the docking station.

• Infrared specifies using the IR port on the back of the netpad.

For details on configuring the Modems dialogue of the Control 
Panel, please refer to the netpad EPOC User Manual.
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4.  Support Services And Worldwide Offices
Psion Teklogix provides a complete range of product support serv-
ices to its customers worldwide. These services include technical 
support and product repairs. 

4.1  Technical Support
Technical Support for the netpad is provided via e-mail through the 
Partner Program website. To reach the website, go to www.psiontek-
logix.com and click on the Partner Program link, which takes you to 
the Partner Program page. Then click on the “Log-in” button or the 
“Register” button, depending on whether you have previously regis-
tered for Teknet or the Partner Program. (Your UserID and password 
are the same for TekNet and the Partner Program.)

4.2  Product Repairs
International
For product repairs, please contact your local Psion Teklogix office 
(see “Worldwide Offices” on page 50). 

Canada/U.S.A
Canadian and U.S. customers can receive access to repair services, 
by calling the toll-free number below, or via our secure website. 

Note: Customers calling the toll-free number should have their 
Psion Teklogix customer number or trouble ticket 
number available.

Voice: 1 800 387-8898 (press option “2”)
Fax: 1 905 812-6304
Web Site: http://service.psionteklogix.com
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4.3  Worldwide Offices

COMPANY HEADQUARTERS 
AND CANADIAN SERVICE 
CENTRE

Psion Teklogix Inc.
2100 Meadowvale Boulevard
Mississauga
Ontario
Canada L5N 7J9
Tel: +1 905 813 9900
Fax: +1 905 812 6300
E-mail: salescdn@psion.com

INTERNATIONAL SUBSIDIARIES

Psion Teklogix GmbH
Jakob Kaiser Straße 3
D-47877 Willich Münchheide
Deutschland
Tel: +49 2154 9282 0
Fax: +49 2154 9282 59
E-mail: info@teklogix.de

Psion Teklogix S.A.
La Duranne
135 Rue Rene Descartes
BP 421000
13591 Aix-En-Provence
Cedex 3; France
Tel: +33 (0) 4.42.908.809
Fax: +33 (0) 4.42.908.888
E-mail: tekeuro@psion.com

NORTH AMERICAN 
HEADQUARTERS AND U.S. 
SERVICE CENTRE

Psion Teklogix Corp.
1810 Airport Exchange Boulevard
Suite 500
Erlanger, Kentucky
USA 41018
Tel: +1 859 371 6006
Fax: +1 859 371 6422
E-mail: salesusa@psion.com

Psion Teklogix (UK) Ltd.
Bourne End Business Centre
Cores End Road
Bourne End
Buckinghamshire SL8 5AR, England
Tel: +44 1628 648800
Fax: +44 1628 648810
WWW: www.teklogix.co.uk
E-mail: tekuk@psion.com

Psion Teklogix AB
Stora Badhusgatan 18-20
411 21 Göthenburg, Sweden
Tel: +46 31 13 15 50
Fax: +46 31 13 57 80
E-mail: info@teklogix.se
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Psion Teklogix Finland
Metsänneidonkuja 8
02130 Espoo
Finland
Tel: +358 9 4307 8390
Fax: +358 9 4307 8395
E-mail: tekeuro@psion.com

Psion Teklogix Danmark
Vesterballevej 4-6
7000 Fredericia
Danmark
Tel: +45 76 24 0133
Fax: +45 75 94 4679
E-mail: tedk@psion.com

Psion Teklogix Italia S.r.I
Via Galilei, 47
20092 Cinisello Balsamo
Milan, Italy
Tel: +39 2 6604 5410
Fax: +39 2 6604 5412
E-mail: tkxitalia@psion.com

Psion Teklogix Inc. (Singapore)
583 Orchard Road
# 15-01 Forum
Singapore 238884
Tel: +65 735 8108
Fax: +65 733 5990
E-mail: intl@psion.com

Psion Teklogix de Mexico, S.A. 
de C.V.
Sierra Mojada 626, 2º Piso
Col. Lomas Barrilaco, C.P. 11010
Mexico, D.F., Mexico
Tel: +52 55 5 327 1124
Fax: +52 55 5 327 1123
E-mail: salesusa@psion.com

Psion Teklogix do Brasil, Ltda.
Al. Casa Branca, 851 - conj. 101 e 102
São Paulo - SP - 01408-001
Brasil
Tel: +55 11 3064 0868
Fax: +55 11 3068 8198
WWW: www.teklogixbrasil.com.br
E-mail: tekbr@psion.com

Chile Psion Teklogix Interna-
tional Inc.
Avenida Vitacura 2909, Oficina 703
Las Condes
Santiago, Chile
Tel: +56 2 334 9344
Fax: +56 2 233 3868
E-mail: ventas@psion.com

Psion Teklogix de Argentina, 
S.A.
Avenida Moreau de Justo 1180
Piso 1, Oficina C-105
Buenos Aires 1107
Argentina
Tel: +54 11 4343 0193
Fax: +54 11 4343 6310
E-mail: tekar@psion.com
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Psion Teklogix España, S.L.
Cityparc Ronda de Dalt
Ctra. Hospitalet 147-149
Edificio Atenas 2° 3ª
08940 Cornellà de Llobregat (Barce-
lona)
España
Tel: +34 9 3475 0220
Fax: +34 9 3475 0230
E-mail: teklogix@apdo.com

Psion Teklogix Africa
Postnet Suite 39, Private Bag x11
Halfwayhouse, 1685 Ground Floor 
East
Waterfall Edge Phase 2, Waterfall 
Park
Bekker Road MIDRAND 1685
South Africa
Tel: +27 11 805 7440/1/2
Fax: +27 11 805 7444

Psion Teklogix Benelux
Nieuwe weg 1, 
2070 Zwijndrecht
Belgium
Tel: +32 (0)3 250 22 00
Fax: +32 (0)3 250 22 20
E-mail: info@psionteklogix.be

Psion Teklogix Systems India 
Pvt. Ltd.
M-74, 1st Floor, “M” Block Market
Greater Kailash-Il
New Delhi - 110048
India
Tel: +91 11 26219257
Fax: +91 11 26219076
E-mail: tekind@psion.com

Psion Teklogix B.V.
Venrayseweg 57, 
5928 NZ Venlo
Nederlands
Tel: +31 77 32400 44
Fax: +31 77 32400 53

Psion Teklogix Taiwan Co., Ltd.
15FL-5, No. 366 Boai 2nd Road,
Tzuo Ying District, KAOHSIUNG 813
Taiwan, R.O.C.
Tel: +886 7 558 2028
Fax: +886 7 558 3328
E-mail: jerry.chen@teklogix.com

4.4  Worldwide Web
www.psionteklogix.com
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